
Ringtail Basics 
Quick Start Guide 
 
 Ringtail 9 brings a new level of simplicity, ease of use, 
and efficiency to document review. The following pages 
walk through scenarios, based on common tasks, to 
show the Ringtail features that make the interface easier 
to use and that add speed and accuracy to review tasks. 

Updated for Ringtail 9.1 

Note: Your administrator must enable and configure some features. 



Follow the Ringtail link and log in to Ringtail. 

Note: Your user name is not case-sensitive. Your password 
is case-sensitive and must adhere to the password 
parameters for your organization. 
 
If you are logging in for the first time, you will be prompted 
to accept the End User License Agreement. 

On the Portal Home page, click the link for a case. 

Log in and select a case 

Log in and select a case 



View updates and notifications 

U
pdates and notifications 

Click the Notifications bell on the toolbar on the Portal Home page to see notifications from your 
administrator.  
 
Note: Your administrator must enable and configure some features. 
 
A “What’s new in Ringtail” box is available on the Portal Home and Case Home pages. Follow the link in this 
box to read about recent changes to Ringtail.  
 

Tip: While you’re on this page, check out the 
latest training videos. 



N
avigate the interface 

Navigate the interface - New Case Home page design 

This version of Ringtail includes a redesigned Case Home page with a new Case Site Map that allows you to 
access key features in Ringtail more quickly. Ringtail also remembers the last page that you accessed. For 
example, if you were on the My Assignments page before logging out, the next time you log in, Ringtail 
automatically displays the My Assignments page. 
 
Your administrator enables and configures some of the options on the navigation menu and features on the 
Case Site Map page.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Group member (sample view) 

Group leader (sample view)  



N
avigate the interface 

Navigate the interface - New Case Home page design 
My Assignments and Review Dashboard 

Users with permissions can access the following pages from the navigation pane on the Case Home page: 
 
 
 
 
 
 
 
 
 
 

My Assignments 

Review Dashboard 

On this page, you can get 
your assignments, clear 
completed assignments, 
and revoke, suspend, and 
unsuspend assignments. 



N
avigate the interface 

Navigate the interface - New Case Home design 
Concept Cloud 

This new feature displays a word cloud of the concepts that were found in a specific document set. The larger 
the word, the more common the concept is. You can display concepts for all documents in the case, or for 
documents in a binder, issue, population, sample, or workflow or phase. Use the slider to hide common 
concepts and display less common concepts. 
 
To view documents that contain a concept, click a word in the Concept Cloud. For example, if you click the 
word “court” in the Concept Cloud, Ringtail performs a search and displays your results on the Documents 
page.  
 
 
 
 
 
 
 
 
 
 
 
 

Note: Your administrator 
must enable and configure 
some features. 



Case Home page – User interface elements 
The Case Home page includes some or all of the following items: 
 
Navigation bar: This bar at the top includes the following items (from left to right): 
• Ringtail logo: Click the Ringtail logo to navigate to the Portal Home page from any page in the case. You can open 

a different case from the Portal Home page. 
• Case name: Click the case name to return to the Case Home page from any page in the case. 
• Case Home menu: Use this menu to access different areas of Ringtail, such as the Documents page or the Review 

Setup page. The Case Home menu and Documents option always appear. The Transcripts option appears if you have 
permission to access transcripts that are loaded in the case, and the remaining menu options appear if you have 
permission to access the associated pages. 

• Quick search box: The quick search box always appears. 
• Quick search menu: Use this menu to change the quick search options. The options that appear on this menu 

depend on your permissions. 
• Group name and menu: If you belong to multiple groups, you can switch between groups that are listed on the 

menu. 
• User name and menu: Hover over your user name to view details. To log out of Ringtail, click Log out on the menu. 

You can also click the user name menu to set search preferences, reset your workspace to the default settings, or 
access bookmarks. 

Toolbar: This bar includes the following items: 
• Breadcrumb and breadcrumb menu: Breadcrumbs allow you to track and navigate back to Ringtail pages. Click 

the arrow next to the Home button to open the breadcrumb menu, which displays the same list of Ringtail pages as 
the Case Home menu. 

• Browse: Click this button to open the Documents page with a workspace that contains the Browse pane. 
• Search: Click this button to create a new advanced search on the Search page.  
Case Site Map: Allows you to access key features more quickly, such as assignments or cubes. You can also access your 
results history and document history. If enabled, this page also includes a “What’s new in Ringtail” section. Follow the 
link to read about the latest Ringtail features. 
Information bar: The information bar at the bottom of every page provides the online help button, as well as 
copyright and version information. 

N
avigate the interface 



Navigate the interface – Documents page overview 

On the Documents page, you can browse, find, review, and code documents.  
Note: Your administrator must enable and configure some features. 
 
To access the Documents page, if you’ve already returned a results set, on the Case Site Map on the Case 
Home page, click a link under Results History or Document History. 
 
 
 
 
 
 
Ringtail displays the Documents page with the default workspace.  
 

N
avigate the interface 

Note: If you have not previously 
returned search results, click the Search 
button on the Case Home page. After 
you run a search, a link to your search 
appears on the Case Site Map. 



Documents page – User interface elements 
This page includes some or all of the following items on the toolbar (from left to right): 
 
 
 
 
 
• Search results arrows: Use the arrows on the left to quickly browse through search results.  
• Search description: Click the description of the search results to open the search.  
• Document information: This information appears below the search results arrows and can include the 

following information: 
• Search preferences indicator: a paper clip icon appears if Sources and attachments was enabled 

for the search, a threaded icon appears if Threading was enabled, and a rendition icon appears if 
Renditions was enabled. 

• Total document count. 
• Selected document count. Click to quickly unselect these documents. 
• The active Document ID and a button that allows you to copy the active Document ID to the 

clipboard. 
• Browse: Click the Browse button to open the Browse pane, if it is not already open. 
• Search: Click the Search button to create a new advanced search. 
• Workspaces buttons and menu: To change the current workspace configuration, click a different 

workspace button. To launch a menu that allows you to add a new workspace, modify an existing 
workspace, or select workspaces to display on the toolbar, click the arrow next to the workspaces button. 

• Tools: To use document tools, click the arrow next to the Tools button. 
• Document arrows: Use the arrows on the right to quickly browse through documents in the results set. 
 

N
avigate the interface 



 
 
 
 
You can set preferences for searches, including whether to include threaded documents, attachments with 
source documents, or renditions in your searches. You can also include line numbers in your search results 
in the List. 
 
The Search preferences menu option is available on the user name menu on the navigation bar of any page 
in the case. 
 
Note: No options are selected by default. 
 
 
 
 
 
 
 
 
 
Once saved, Ringtail applies your preferences to your next search and to subsequent searches. Search 
preferences available to you depend on the permissions set by your administrator. 
 
 
 
Note: The options that you set on the Search preferences menu sync with the search preference options at 
the bottom of the Search page. 
 

Set search preferences 

Search 



 
 
 
 Use the quick search box, which is available on 
the navigation bar of all pages in the case, to 
perform simple searches.  
 
Simply start typing in the quick search box to 
start your search. In the results list, you can 
filter by certain search parameters, as well as 
manage results for such options as binders (if 
permission is enabled). 
 

The quick search menu, available by 
clicking the button on the right side of the 
quick search box, lists the types of 
searches that you can perform (as set by 
your administrator). 
 
Note: Only one option, Document 
Content, is selected by default. 
 

Run a simple search 

Search 



 
 
 
 Access the Search page by clicking the Search button on the Case Home page or the Documents page. 
 
 
 

• Select from a wide range of fields, operators, and values. 
• To set search preferences, select the check boxes at the bottom of the page. 

• Note: No options are selected by default.  
• To run the search, click Search.  

Perform an advanced search 

• To create a new search, click the Search button on the toolbar. 
• To use the previous search criteria in a new search, click the search results name 

on the toolbar. 

Use the Search 
menu to create a 
new search, or to 
copy, open, save, or 
delete a search. You 
can pin these 
options to the 
Search toolbar. 
 
Note: If you 
attempt to save an 
existing saved 
search, a 
confirmation dialog 
box appears and 
you must click OK 
to confirm 
overwriting the 
existing saved 
search. 

Search 



Add new clause 

Add additional criteria (Coded by) 

Remove additional criteria 

Delete clause 

Create group 

Remove from or delete group 

View selection (for example, mines and cubes) 

Search 

 
 
 
 Build your search using the values, operators, and buttons on the Search page. 

Build a search query 

Tip: Click the 
Keyboard 
Shortcuts button 
on the toolbar or 
Search menu to 
open the keyboard 
shortcuts window 
and build your 
search without 
using a mouse. 

Search 

Gray bracket: Group of search queries. 
Green bracket: Group of search queries joined by an “or” 
operator. 
Red bracket: Group of search queries joined by an “and” 
operator. 
Blue bracket: Group of search queries joined by a “not” 
operator. 



 
On the Case Home page or Search page, click the Browse button on the toolbar to access the Browse pane. 
In the Browse pane, you can perform the following tasks: 
 
• Find document content or coding hits 
• Browse for documents in a binder, issue, level, or saved search 
• Filter documents by search term families, concepts, or quick codes 
 
 
 
   
 
 

• When you click the Browse button, the first workspace that includes 
the Browse pane appears, and displays the Browse features available 
to you.  

• In the top pane, you can use the Find feature to search document 
content or coding. You can filter documents by search term families, 
concepts, and quick codes. For example, you may need to locate all 
documents for a specific concept and code them as responsive.  

• In the bottom pane, you can browse documents in binders, issues, 
levels, and saved searches. For example, you may need to locate 
documents that have been designated with a specific issue. 

• The Browse pane also includes additional functions for managing a 
specific feature, adding and modifying descriptions, and 
downloading concept reports. 

• Open the Browse menu to access additional options, such as the 
Refresh button. You can pin options to the Browse pane menu. 

Brow
se pane 

Work with the Browse feature 



 
Browse for documents 

To browse for documents, on the Documents page, in the bottom pane of the Browse pane, click the link 
for a binder, issue, level, or saved search. The documents appear in the List and the first document in the list 
appears in the View pane, if your workspace is configured to display these panes. 

Brow
se pane 

 



 
Filter documents using the Browse pane  

After you open a document set, you can filter the documents in the List (or Map) using the features in 
the top pane of the Browse pane (search term families, concepts, and quick codes). The following 
figure shows the results for a search term family. 
 

Brow
se pane 

Using the Find feature, you can search for 
results (called hits in Ringtail) in a 
document's content or coding, or both.  



The workspace is the arrangement of panes on the Documents page. The workspace appears when you open 
the Documents page after you run a search or browse a document collection.  
 
 
 
 
 
 
 
 
 
 
 
 
 
You can perform different tasks in each pane, as follows: 
 
• Use the Browse pane to find document content or coding hits, or filter documents by search term families, 

concepts, or quick codes. You can also browse for documents in a binder, issue, level, or saved search. 
• Use the List pane to view information about each document, along with coding and document details. 
• Use the View pane to view a document’s text content, native files, or image view. 
• Use the Code pane to code documents. 
• Use the Conditional Coding pane to code documents. 
• Use the Map pane to see an alternate view and visualization of documents that are clustered based on the 

similarity of concepts.  
• Use the Timeline pane to review the distribution of documents over time and how they intersect with 

other information, such as concepts, quick codes, content searches (find), and search term families.  
• Use the Related pane to view a list of documents that are related to each other based on threaded 

relationships or on source and attachment relationships. 

About the Workspace feature 

W
orkspace 

Tip: You can collapse 
any of the panes, if 
you need more space. 



Customize the workspace 

W
orkspace 

To add a new workspace or edit an existing workspace, 
open the workspace menu. 
 
Then click Add new workspace or Edit current 
workspace. 
 
You can configure a workspace to contain up to five 
panes, including List, Map, Browse, Code, Timeline, 
Conditional Coding, View (A), View (B), or Related. 

Multiple workspaces are available by 
default. You can pin up to three 
workspaces to the toolbar.  
 
Note: If you do not see the default 
workspaces, on the user name menu, 
under User settings, select Reset to 
Ringtail default. 
 
To change the current workspace, click 
one of the three pinned workspace 
buttons (A, B, or C) on the toolbar or click 
a workspace on the workspace menu.  
 
To pin a different workspace to the 
toolbar, open the workspace menu, and 
then click the pin next to a workspace. 



 
 
 
 

Work with documents in the List pane (standard view) – Overview 

When you search for documents, the results typically appear in the List pane on the Documents page. The List 
pane includes information about each document, along with coding and document details.  
 
Note: You can display line numbers in the List pane, which you can set under Search preferences on the user 
name menu or on the Search page. 
 
 
 
 
 
 
 
 
 
 
 
 

List pane 

Use the List pane to perform the following tasks: 
 
• Select documents to view and code 
• Select documents for the Working list 
• Apply quick coding to documents 
• Modify which columns appear in the List pane 
• Work with threads 
• Work with base documents and renditions 
• Filter and search the documents in the List 

pane 
• Open a document in a linked workspace or in 

a standalone window 
• Copy a link 
• Find similar documents 



 
 
 
 

Configure columns in the List pane 

In the List pane, you can select, sort, order, add, and delete columns. You can add as many columns 
as you need. You cannot remove or change the position of locked columns in the List pane. 
 
 
 
 
 
 
 
 
 
 
 
 
 

List pane 



 
 
 
 

Filter columns in the List pane 

After performing a search, you can narrow your search results by filtering the columns in the List pane. You can 
filter for text, dates, yes/no values, or numbers. List pane 

Text filter 

• To return to the unfiltered results for the search, click the left arrow button on the left side of the 
toolbar. 

• Once you apply a filter, the criteria used for the filter become part of the search label. You can then 
click the label to open an advanced search with these criteria on the Search page. 

 



Edit fields inline in the List pane 

You can make inline edits to the following field types in the List pane: pick lists, number, yes/no, memo, and 
user generated 1-to-1 date fields. 
 
Note: The field must be set to writable by your administrator before you can edit it.  
 
Click on a field to edit its value.  

 

List pane 

Pick list field 

Tip: You can undo changes made to editable fields in the List. 



 
 
 
 

Work with the email threading feature 

Threading-specific elements include the 
following: 
 
• Pivot documents, which contain all 

unique content. A thread can have 
one or more pivots. 

• Recipient and attachment changes 
within a thread. 

 
Note: You can use the expand all and 
collapse all buttons to view all threads 
or just pivot and root documents. 
 
 
 

The email threading feature analyzes document content and organizes the documents into threads. In 
threaded view in the List pane, you can review documents using both standard and threading-specific 
elements.  

In addition to these review elements, use email threading to do the following tasks: 
 
• Shorten review time by removing duplicate documents and coding only pivot documents. 
• Increase review efficiency and accuracy by reviewing threaded documents together. 
• View other thread information, such as the thread analysis status, thread ID, thread order ID, and the 

threaded document type. 

List pane 



 
 
 
 

Work with the email threading feature 

Note: To view threaded results in the List, your 
administrator must first grant access to email 
threading features. 
 
You can perform the following steps: 
 
• Return a set of documents. 
• Add documents to thread analysis or remove 

documents from thread analysis by using the 
option on the Tools menu. 

• After Ringtail has analyzed the documents and 
created threads, review the threaded documents. 

 
Note: You must select the Threading option on the 
Search preferences menu (on the user name menu 
or on the Search page). 
 
 
 

List pane 



Review documents in the View pane 

View
 pane 

When you review a document, you determine the document's relevance to a case and identify any 
important content. You review the contents of individual documents in the View pane. 
 
The View pane includes different view options to allow you to review a document in the format that is 
most appropriate for the document type, the case strategy, and the overall goals of the review. Because 
you can see different content in each view, it is important to review documents in all views.  
 
Depending on the tasks that you want to accomplish, the type of document you are reviewing, and the 
specific content that you want to review, you can view a document in the following formats: 
 
• Formatted content: Displays the text extracted from a document, with simple formatting applied. 

Unformatted content: Displays the text extracted from a document without any formatting.  
• Native: Displays a document in the native file format of the original application that created the 

document, using the Quick View Plus viewer.  
• Office Online viewer: Displays a native document in Microsoft Office Online directly in the browser. 

Note: The specific Office Online features that are available depend on your organization's license with 
Microsoft and the portal options that are configured by your administrator. 

• Image viewer: Displays image files, PDF documents, and media files.  
 



The following tables describe the features in the View pane. 

View pane features (1 of 2) 

View
 pane 

  Element Purpose 

Formatted content 
 
 

Displays the text extracted from a document, with simple formatting applied. 
 

Unformatted content 
 
 

Displays the text extracted from a document without any formatting. 
 

Native 
 
 

Displays a document in the native file format of the original application that created the 
document, using the Quick View Plus viewer. 
 

Office Online viewer 
 
 

Displays native files in Microsoft Office Online directly in the browser. 

Image viewer 
 
 

Displays image files, PDF documents, and media files.  

Document type 
 
 

Indicates the document type. If quick coding is enabled, click the document type button 
to apply a quick code to a document. 
 

Source/Attachment family 
 
 

A colored line next to the document type button indicates that the document is part of 
a document family. A document family contains a group of documents made up of a 
source document and its attachments. The color of the line indicates the quick code 
value that has the highest family rank within that document family. 



View pane features (2 of 2) 

View
 pane 

  

Element Purpose 

Hidden content warning 
 
 

Indicates that a native file includes hidden content, such as tracked changes, speaker 
notes in a presentation, or hidden columns in a spreadsheet. Hover over the warning 
icon to determine the type of hidden content that the document contains. 

Truncated content warning 
 
 

Indicates that a document is larger than the maximum file size set by your 
administrator. To view the document, switch to Unformatted content view. 
 

Document ID 
 
 

The ID number of the document that appears in the View pane. The document ID is a 
unique number that is associated with each document in the database. 
 
The document that appears in the View pane is also called the active document. 

Keyword hit navigation 
 
 

Displays the number of keyword hits in the document. To navigate between keyword 
highlights in the document, click the Next hit or Previous hit buttons. 

Keyword highlights 
 
 

Displays keyword highlights and allows you to conduct ad hoc content searches. 

Download 
 
 

Downloads a document in its original file format. 

Update pages 
 

Allows you to add or remove pages in a document, if you have permission to do so. 

Collapse Collapses the View pane. 

View menu and options The View menu includes options for working with documents in the View pane. 
Note: You can pin any of these buttons to the View pane toolbar. 



Review documents in the View pane - Formatted content view 

View
 pane 

  

Formatted content: Displays the text extracted from a document, with simple formatting applied.  
 
You can perform the following tasks: 
• View keyword hits 
• Conduct ad hoc keyword searches 
• Search for similar documents based on a selection of text 
• View streamlined Bloomberg chats, with interactive color-coding based on participants' organizations 



Review documents in the View pane - Unformatted content view 

View
 pane 

Unformatted content: Displays the text extracted from a document without any formatting.  
 
You can perform the following tasks: 
• View keyword hits 
• Conduct ad hoc keyword searches 
• Search for similar documents based on a selection of text 



Review documents in the View pane - Native view 

View
 pane 

Native: Displays a document in the native file format of the original application that created the 
document, using the Quick View Plus viewer.  
 
You can perform the following task: 
• Search for content 
 
 



Office Online viewer: Displays native files directly in Ringtail using Microsoft Office Online. You can review 
native files without having to download documents to your computer. 

Review documents in the View pane - Office Online viewer 

View
 pane 

Note: Depending on the portal configuration, you may be able to edit documents temporarily, such as 
adding temporary highlights. Ringtail does not save any edits that you make in the Office Online viewer. 

* The availability of features marked with an asterisk (*) depends on your organization's license with 
Microsoft and the portal options that are configured by your administrator. 

You can perform the following tasks: 
• Search for content 
• See formulas*, resize columns, 

and display hidden worksheets, 
rows, and columns* in a 
Microsoft Excel spreadsheet 

• View comments in Microsoft 
Word*, Microsoft Excel, and 
Microsoft PowerPoint 

• View slide notes*, slide 
thumbnails*, and hidden slides* 
in a Microsoft PowerPoint 
presentation 

• Use standard Microsoft Office 
features to review content* 

• View native files that were 
created in applications other 
than Microsoft Office 



Review documents in the View pane - Image viewer 

View
 pane 

Image viewer: Displays image files, PDF documents, 
and media files.  
 
You can perform the following tasks: 
• View imaged document pages 
• Add annotations such as highlights or redactions 
• Convert highlights to redactions, and convert 

redactions to highlights 
• Add notes to specific document pages 
• Print a document 
• Watch video files and listen to audio files 
• View comprehensive Bloomberg chats, including 

event logs and noise 
 
 



Coding a document is the process of marking a document with the information that you identify during a 
review. Documents that are coded as responsive can then be produced and provided to a third party in 
response to a discovery request. Depending on your case, you can code documents in the Code pane or the 
Conditional Coding pane.  

Code documents in the Code pane 

Code pane 

You can perform the following coding tasks: 
 
• View the existing coding values for a document, 

locate documents that are coded with the same 
values, or configure the layout of the Code pane.  

• Quickly code a document by selecting a color-
coded value from a list.  

• Apply suggested coding values to a document 
using hints.  

• Add or update values in individual coding fields.  
• Code documents to issues. 
• Code documents to binders. 
• Code documents to people or organizations. 
• Link a document to related objects, such as other 

documents, shared binders, issues, levels, saved 
searches, transcripts, or websites.  

 
 
  



Code documents in the Code pane 

• To save field edits, press Tab or 
Enter. 

• To delete field edits, click the 
field value, and press Delete. 

• Multivalue fields display a plus 
sign and allow you to code 
multiple values. 

• When coding pick list fields with 
many values, type a few letters 
to narrow the list of values. 

Tip: To apply values from 
the previously displayed 
document, use coding 
hints. 

To edit a field, click in any 
field with a blue triangle 
and change its value.  

To apply issue coding, on 
the All Values menu, 
select Issues, and then 
select one or more check 
boxes.  

To change the quick code 
value, click the blue dot.  

To search for documents 
that have the same 
coding, click the 
magnifying glass.  

Code pane 



When you code documents in the Conditional Coding pane, you can quickly determine which fields you 
should code depending on the values that you provide for related fields. After you code each field, the 
colors of the remaining fields change to indicate which fields you still need to code. 

Code documents in the Conditional Coding pane 

Conditional Coding pane 

Fields that you have already coded appear in 
green, fields that your administrator does not 
expect you to code appear in gray, and fields 
that must still be coded appear in white. 
 
If you code a value that is unexpected based on 
the other values that you have coded, the field 
appears in yellow and a warning message 
appears. 

Note: To access this feature, add a Conditional 
Coding pane to your workspace. 



 
 
 
 

Work with the Map 

You can perform the following tasks with the Map: 
• Review documents based on their concepts. 
• Explore concepts that tend to appear together in selected documents. 
• Find documents that share common concepts. 
• Apply quick codes to one or more documents directly in the Map. 
• Find documents that have the same quick code or the same family quick code. 
• Select multiple documents for a bulk action, such as coding or adding documents to a binder. 
• Search the Map for keywords to locate clusters and documents with those terms. 
• Select a document to preview in the View pane or in a standalone workspace. 
• Discover new concepts in the documents. 

The Map is an alternate view of documents in 
an assignment or a search results set in which 
documents are clustered based on the similarity 
of concepts.  
 
You can navigate from document to document, 
view relationships between documents, search 
documents, and code documents while viewing 
the Map.  
 
You can display up to 10,000 documents per 
page. 

M
ap pane 



 
 
 
 

Map elements 
The Map pane contains the following elements: 
 
Concept cluster: A group of documents in a spiral arrangement in a circle. The circle may appear solid when 
you first open the Map, indicating that all the documents in the cluster have the same quick code value. You 
can configure the Map to always display individual document dots. 
Cluster tooltip: A tooltip that appears when you hover over a cluster. The tooltip displays the concept shared 
by clusters displayed on the spine. When spines intersect, multiple concepts display at the top of the infotip. 
The tooltip displays the top concept, the next highest six concepts, the number of documents in the cluster, 
the percent of documents coded, and the top document titles in the cluster. You can also configure the Map 
to position the tooltip in the corner of the pane. 
Concept compass: The ring that surrounds concept clusters. Clusters can appear inside or outside the ring 
depending on the cluster configurations.  
Map menu: The menu associated with the Map pane that lists options for using and configuring the Map. All 
of the options on the menu can be pinned to the Map toolbar for easy access. 
Page navigation window: A small window on the side of the Map that appears when the Map includes 
more documents than can be displayed on one page. Use the navigation controls to move through 
documents on additional pages of the Map. You can configure the number of documents to view per page 
on the Options menu. 
Set-aside clusters: Square containers, or clusters, in the lower right for storing coded documents. The color 
indicates the quick code value. Use the Quick Codes section in the Browse pane to move documents between 
the Map and the set-aside clusters.  
Spine: A line that connects clusters that have one or more significant concepts in common. Along a spine, 
documents in adjacent clusters are more similar to each other than to documents in clusters that are farther 
away. 
Spine label: The concept that clusters in a spine have in common. The spine label appears around the 
concept compass. Spine labels can provide a quick overview of the key concepts in an area of the Map. 
Triangle: Indicates the active document. 
Zoom slider: A vertical control on the right side of the Map that allows you to zoom in and out of clusters. 

M
ap pane 



 
 
 
 

Customize the Map 

Although the default display in the Map is sufficient for most review work, you may want to modify what you 
see in the Map. Options for configuring the Map appear on the Options menu, which you can access 
through the Map menu. 

• Spines: Shows or hides the spines that join concept clusters. 
• Compass: Shows or hides the compass ring. 
• Labels: Shows or hides the concept labels that appear around the compass ring. 

• Pointers: Shows or hides the lines that connect related concept clusters 
to the concept labels. 

• Show tooltip: When you hover over a cluster, displays a tooltip that provides 
information about the documents in the cluster. 

• Pin tooltip: Displays the cluster tooltip in a corner of the Map so that it 
does not cover up the Map. 

• Set-aside on family code: Automatically places all of the documents in a 
document family in the set-aside cluster that matches the documents' family 
code (the highest-ranking quick code value for the family). When this option is 
not selected, each document is placed in the set-aside cluster that matches the 
document’s individual quick code. 

• Solid for uniform coding: If all of the documents in a cluster have the same 
quick code, the concept cluster appears as a solid color. If documents within the 
cluster have different quick codes, the cluster shows individual colored dots. At 
lower display percentages, the cluster appears as a pie chart which represents 
mixed coding in a cluster. 

• Working list: Displays the Working list view in the List pane. 
• Page size: Sets the number of documents to display on each page. The default 

is 2,500, although you can display up to 10,000 documents per page. 

M
ap pane 

Tip: On the Tools menu, you can select a color theme for the Map and the Timeline. 



 
 
 
 

Work with the Timeline  

In the Timeline pane, you can review the distribution of documents over time and how they intersect with 
other information, such as concepts, quick codes, content searches (find), and search term families.  
 
• The time field used to configure the Timeline is set at the case, group, and user level.  
• The Timeline feature can be used with result sets up to 50,000 documents.  
• You can select documents by date range or by time interval.  

Tim
eline pane 

You can perform the following tasks with the Timeline: 
 
• Select documents in a time range, a specific time interval, or a selection of specific time intervals. 
• As a reviewer, select a different Timeline date field to use during a review. 

Tip: On the Tools menu, you can select a color theme for the Map and the Timeline. 



 
 
 
 

Work with Tools on the Documents page 

A number of tools that were previously available on the Extensions tab in the Code pane are now available 
on the Tools menu on the Documents page. You can pin the options on the Tools menu to the toolbar. 
Some of the tools have been renamed. 

Tools The following tools are still located on the Extensions tab in the Code 
pane: 
 
• Batch Print 
• Report 



 
 
 
 

Batch print documents 

Using the Batch Print tool, which is 
located on the Extensions tab in the 
Code pane, you can print documents to 
PDF. After you print documents to PDF, 
you can use the print options in your PDF 
viewer to print hard copies. 
 
You can print documents that contain 
image files or PDF files.  
 
You can print each document separately 
or combine multiple documents into one 
PDF file. 
 
Note: The following new option is 
available in the Batch Print tool: One 
document at a time, PDFs named to retain 
search result sort order. 
 
If you select this option, one PDF is 
created per document. Each file is named 
with the document ID, plus a numerical 
prefix that indicates the order in which the 
documents appeared in the search results. 
All PDFs are then compressed in a zip file. 

Batch print 



 
 
 
 

Review Bloomberg chat documents 
You can review chat documents from Instant Bloomberg chats and persistent chat rooms. Chats are also 
called instant messages. 

Bloom
berg chat 

A chat includes a variety of information. In addition to the messages that participants send to each other, a 
chat can include the following information: 
• Content that participants send to each other, such as messages, attachments, and invitations to ask other 

people to join the chat. 
• Event logs that provide information about participants' actions, such as when a person entered and exited 

a chat, or whether a person viewed the chat history to learn what happened in a chat room before they 
entered. 

• Noise content that is distracting or irrelevant to the review, such as automatic disclaimers that are posted 
when people enter a chat. 

• Metadata, such as the date and time of the chat, the names of participants, and the number of messages in 
the conversation. You can search for chat metadata and use it to focus the review. The metadata for a chat 
document appears in the Code pane. 

 Tip: To search for chat documents, create a 
search that includes the Document Type field 
with a value of Bloomberg Instant or 
Bloomberg Persistent.  
 
 
 
 
 



 
 
 
 

Review Bloomberg chat documents 

Depending on your review strategy, you can review chat documents in the View pane using the following 
views: 
 
• Lite chat: Quickly review only content that participants sent to each other. Lite view displays a subset of 

chat information: messages, attachments, and invitations. The chat is color-coded based on participants' 
organizations. You can identify content that was sent by specific people or organizations by toggling 
participant names, organizations, or actions in the summary table. You can also display or hide keyword 
highlights. 

 
• Full chat: Review all of the information including content that participants sent to each other, event logs, 

and noise content. You can use event logs to determine the full context of a chat. For example, you can 
identify whether an individual participated in a chat when something important was said, even if they 
only viewed the content and did not send a response. As another example, you can analyze an 
individual's view history to determine when they learned about particular information. 

 
Both chat views include a summary table that displays the organization names, participant names, and the 
number of messages (MSG), attachments (ATC), and invitations (INV) that were sent by each participant. 

 
Tip: People frequently use informal language, abbreviations, and jargon in chats, and typos may be common. 
Because of this, you should adjust your search and review strategy to make sure that you do not miss any 
important information. If you use keyword highlights to identify important content, your administrator or 
review lead should make sure that any search term families include all relevant phrases. 
 
If the chat file includes attachments, the attachments are attached to the chat document in Ringtail.  
 
To add annotations to a chat document, such as redactions, you can create an image file of the chat 
document, and then annotate the image file. 
 
 
 

Bloom
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Work with Assignments 

You can access your assignments from the Case Home page by clicking My Assignments in the navigation 
pane or the My Assignments link on the Case Site Map. Your administrator must grant access to this feature. 
 A

ssignm
ents 

Assignment completed 

After you access your assignments on the My Assignments page, Ringtail displays the documents that 
require coding or review. Where the documents appear depends on your workspace configuration. The 
documents typically appear in the List pane. 

If an assignment meets the 
coding requirements, the 
Assignment completed 
dialog box appears and 
includes a link to all of the 
documents in the 
assignment. 

Assigned documents in the List 

On this page, you can get 
your assignments, clear 
completed assignments, 
and revoke, suspend, and 
unsuspend assignments. 



 
 
 
 

Review Dashboard 

You can view the progress of an active review using the Review Dashboard. The Review Dashboard includes 
a progress bar, graph, and reviewer matrix that display the review status of all documents in the case. The 
information in the Review Dashboard is pre-populated to show all documents in the case. If you select a 
different document set, coding field, or team, the dashboard updates accordingly.  
 
To access the Review Dashboard, on the Case Home page, click the Review Dashboard link in the 
navigation pane or the Review Dashboard link under Analysis. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: This feature is available to case administrators by default. Administrators can enable this feature for 
group leaders and group members on the Security > Administration page. 
 

Review
 D

ashboard 



 
 
 
 

Review Dashboard 
The Review Dashboard includes the following information and options: 
 
• Document set: The default option is All documents in the case. You can select a type of document set in 

the list, such as a binder. After you select a type, a second list appears. Depending on the type, select a 
specific document set from the list, or click the arrow and then select a specific document set. The progress 
bar, chart, and reviewer matrix also update to show metrics for the newly selected set of documents. 

• Coding field: This list, located at the top of the Review Dashboard, prepopulates with a quick code field. You 
can change this field to any quick code field currently available in the case. When you select a different quick 
code field from the list, the Review Dashboard updates accordingly. 

• Progress bar: Indicates the percentage of documents that are coded. 
• Estimated completion: Indicates the estimated number of working days that are required to code the 

remaining uncoded documents, based on a rolling average review rate over the past 7 days, excluding 
weekends. 

• Average documents coded per reviewer: Indicates the rolling average of documents that are coded per 
reviewer per day, excluding weekends. 

• Doughnut chart: This chart is located on the right side of the Review Dashboard. It displays the number of 
documents and percentages of coded values for the selected coding field. 

• Team list: This list allows you to select a team. The available teams depend on the teams’ security settings 
for Review Setup. Users with permission to administer teams can choose from any team. Users without 
permission to administer teams can choose from the teams that they are members of. Note: The default 
option is All teams. When you select a different team, the information in the reviewer matrix changes, but 
the rest of the information in the Review Dashboard remains unchanged. 

• Reviewer matrix: This table, located at the bottom of the page, displays coding metrics for individual 
reviewers, such as the average number of documents coded per day. A bar chart for each reviewer shows the 
percentages and number of documents that the reviewer coded relative to each quick code value. Hover 
over a bar to see the details. You can sort the columns in the Documents coded area. 

 
Tip: Use the Download button on the toolbar at the top of the page to export information in the reviewer 
matrix to a spreadsheet (.csv file) format.  

Review
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Work with Search Terms 

Search Terms is a new reporting feature in the Analysis section. 
 
• In the Counts panel, you can view information about search term hits across document sets. You can also 

view how each search term contributes to the overall population of hits at a document and family level. 
• In the Coding panel, you can review how many documents containing a particular term were tagged with 

specific values in a coding field to evaluate search term effectiveness using recall and precision values.  
 
You can download the full report as a spreadsheet (.csv file). 
 
Note: An administrator can make this feature available to group leaders or group members on the Security > 
Administration page. 
 
To access the Search Terms page, on the Case Home page, click the Search Terms link under Analysis. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Search Term
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